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1. Visure Requirements Release Notes 

1.1. Warnings 

• Commercial open database Microsoft SQL Server 2005 is not supported anymore. Microsoft ended 

the extended support for SQL Server 2005 on April 12, 2016 (https://www.microsoft.com/en/server-

cloud/products/sql-server-2005/) 

1.2. Beta evaluation 

If you are installing this version for beta purposes, you may need to observe the following notes.  

WARNING 

DO NOT open your production environment with versions 4.8 or older with this version. If you do so, the 

database will be migrated and you will no longer be able to open it with your older version. 

NOTE 

It is possible to execute several versions of Visure Requirements in the same machine, but it will only be 

possible to have one version fully installed. 

It is recommended to install this version in a different machine, or install this version, evaluate it and 

then uninstall it and install your current version. 

However, if you would like to have several versions in your own computer, follow these steps: 

- Go to the installation folder, typically C:\Program Files (x86)\ and duplicate the 

VisureRequirements folder. 

- Rename the VisureRequirements folder to VisureRequirements4.8, or any other name that will 

help you remember the folder you duplicated. 

- Create a shortcut in your desktop to the VisureRequirements.exe and 

VisureRequirementsAdmin.exe file, naming them in a way that will help you identify the version 

they belong to. You will be able to use these versions as usual. 

- Uninstall your current version of Visure Requirements. WARNING: Before uninstalling, make sure 

you have your original installation files, to be able to install it back after the evaluation. You may 

also download the latest official version from the Visure Community Portal. 

- Install the evaluation version 

You should now have two shortcuts in the desktop, one belonging to the original version, and another 

one for the beta version. 

WARNING 

https://www.microsoft.com/en/server-cloud/products/sql-server-2005/)
https://www.microsoft.com/en/server-cloud/products/sql-server-2005/)
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While working with the duplicated version, you may not be able to generate reports from the Visure 

Report Manager. 

If you would like to evaluate the evaluation version for an extended period of time, you may revert this 

process by duplicating the beta version installation folder, uninstalling it, and then installing your 

original version. 

1.3. Installation from scratch 

If you do not have Visure Requirements installed or you have installed a version prior to Visure 

Requirements 4.9, go through the steps of chapter “VR Installation from scratch” of the installation 

guide. 

1.4. Upgrade procedure 

If you already have installed any version of Visure Requirements previous to version 4.9, after 

downloading the latest version of VR, go through the following steps to complete the installation of the 

new version: 

1. Backup the VR Repository. 

2. Save your Product Key (only Node-Locked licenses). 

3. Save the user settings. 

4. Uninstall the current version of VR. 

5. Download and install the new version of VR. 

6. Apply your Product Key (only Node-Locked licenses). 

7. Upgrade the Visure Database. 

8. Apply the user settings previously saved. 

For detailed information, in the installation guide go to chapter “VR upgrade procedure". 

1.5. Compatibility  

The following product versions are compatible with Visure Requirements 4.9.1.1808: 

• Visure Requirements v4.9 database schema 

• Visure Report Manager 4.7, 4.7.2, 4.8, 4.9 and 4.9.1 

• License Server v4.6 & v4.6.1   

• Visure Dashboards 1.0 

• Source Code integration 4.8 
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• Source Code Unattended integration 4.9.1 

• MS Word Import plugin 1.1.0.275, 2.0.0.300 

• Test Management (TM) v4.8 

• Visure Requirements Prioritization (PPM) v4.8 

• Item Templates (IT) v4.8, v4.9 

• FMEA v4.8 

• ReqIF v1 4.9 

• Search and Replace v4.8 

• Visure Requirements integration with HP ALM v4.8 

• Visure Requirements integration with Enterprise Architect 4.8 

• Visure Requirements integration with Atlassian JIRA 4.8 

• JIRA Unattended integration 4.9.1 

Visure Requirements project templates created with versions 4.7.x or 4.8.x are compatible with version 

4.9.1, so new projects in version 4.9.1 can be created from 4.7.x or 4.8.x ipt files. 

1.6. Visure Requirements 4.9.1 

1.6.1. New features 

1.1.1.1 Dashboards 

The Visure dashboards plugin provides a set of predefined HTML pages, each one of them containing 

customizable widgets that display information on the project, the current specification or a 

predetermined specification. 

These widgets may display information on the progress of the project through general information and 

volatility, fulfillment of a specification through coverage diagrams, or the accomplishment of a test 

execution through Test Status Summary reports. 

1.1.1.2 Source Code integration plugin 

The new source code integration plugin allows importing a folder containing source code files in Visure 

Requirements, representing files and functions as items, in order to be able to trace them to low-level 

requirements. The parser imports over 40 programming languages, including C, C++, C#, Java and VHDL. 

It also includes an unattended mode that helps establish a batch process to keep the source code 

representation in Visure Requirements permanently updated with any modifications in the files. 

1.1.1.3 MS Word import plugin 

The MS Word import plugin creates a new button in MS Word that allows importing complete 

specifications in Visure Requirements. 

This new version allows re-reimport documents by comparing the contents of the MS Word document 

with the information in Visure Requirements, flagging the requirements that have been modified in the 

Word document and those that have been created new. 
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1.1.1.4 Improved project templates for standard compliance 

Visure Requirements provides improved out-of-the-box projec templates for standard compliance for 

Aerospace, Defense, Automotive, Medical Devices and general Systems Engineering environments. 

1.1.1.5 Quick insert 

Visure implements an enhanced way of creating items intended to helps users in the requirements 

authoring. Visure provides two modified buttons, Add Item (INS shortcut) and Add Child Item (Shift + INS 

shortcut). When these options are selected, instead of displaying a dialog box a new item (or child item) 

will be created automatically right after the selected one. The new item will have the following 

characteristics: 

- The new item will belong to the same item collections as the selected one 

- The new item will belong to the same access partition as the selected one 

- The name of the new item will be empty, or display a dash “-” if empty names are not allowed. 

- If the corresponding option is selected, the new item will inherit the same attribute values, except 

for the workflows, as the selected item. 

- If the corresponding option is selected, the new item will inherit the same incoming relationships 

as the selected item. 

- If the corresponding option is selected, the new item will inherit the same incoming relationships 

as the selected item. 

Visure provides a new Configure Quick Insert option in the Edit menu, where the user will be able to 

configure the behavior of the Quick Insert feature. 

Through the Edit menu, the user will be able to create up to 10 items in bulk. 

1.1.1.6 Add related feature 

Visure displays a new Add Related option, that will allow the user to create a new item automatically 

related to the selected item. When selecting this option, a dialog box will be displayed allowing the user 

to select the type of the new item (item collection), which will depend on the items that can be related 

to the selected one. For instance, if a Product Requirement is selected, only System Requirements and 

Acceptance tests may be created, but not Software Requirements. This will depend on the specific Data 

Models used in the project. 

Please note that the new item will only belong to the selected item collection, so the new item might 

not be displayed in the current view. 

1.1.1.7 Create database template 

The Visure Administration Center includes a new capability when right-clicking to expor the complete 

database to an ipt file, that will contain all of the information in the database. 

1.1.1.8 New tutorial 

Visure now incorporates a new tutorial project that explains a more efficient and proven way of using 

Visure Requirements, aligned with the existing Visure Requirements templates. This tutorial features 
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Requirements Management, Test Management, Change Management, Defect and Issue tracking and 

Risk Management. 

1.1.1.9 New triggers in plugins 

The Plugin SDK provides new triggers that can be used to launch actions when a specific action is 

performed. 

1.1.1.10 New integration framework for unattended integrations 

The new integration framework provides the skeleton for the development of an integration. This 

skeleton now provides the capability to execute the configuration based on a batch file, which enables a 

synchronization of items between tools in the background without user´s interaction. 

1.6.2. Enhancements and Usability Improvements 

1.1.1.11 Smooth scrolling 

Visure implements a new scrolling mechanism in which the user will be able to scroll smoothly through 

the requirements in a MS Word-like way, opposed to the previous cell scrolling (MS Excel-like). This new 

scrolling capability will allow users to scroll through descriptions larger than the actual screen height for 

specifications smaller than 1,000 objects. 

1.1.1.12 Description cache 

Descriptions now implement a new cache mechanism that allows a quicker representation when 

displaying larger images and OLE objects. Once the image is loaded in the cache, it will be displayed 

almost instantaneously, improving performance significantly when working with larger requirements. 

1.1.1.13 Relationship cache 

Relationships now implement a new cache mechanism that allows a quicker representation of the Link 

Indicators column, as well as the Link Types columns. This cache significantly improves the performance 

when displaying large amounts of links in the view. 

1.1.1.14 Status of the navigation panel 

The navigation panel will display the hierarchy collapsed by default so that users are able to find the 

desired specification and objects in an easier way. Once the application is opened, the navigation panel 

expand/collapse status will not change unless the user does so manually. 

1.1.1.15 Access to panels from context menu 

The Edit menu and the context menu now displays an option to show the Description and Properties 

panel. 

1.1.1.16 New shortcuts 

The description panel features two new shortcuts including Ctrl + S to save and Ctrl + I to apply italics to 

the selected text.  

 

1.6.3. Solved Issues 
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1.1.1.17 Visure Requirements Client (8) 

 

• CR_21620      479                Increase the number of views in drop down menu 

Problem definition 

It is not possible having more than 25 views 

Solution definition  

The number of views in the drop down menu should be increased to 50 

 

• CR_21670 Shared Predetermied view overwrites user`s predetermined view 

Problem definition 

The user`s predetermined view should prevail over a shared predetermined view. 

Currently, if a view is shared and established as predetermined, the user cannot changed it, even if the 

user establishes another one as predetermined. 

Solution definition  

User´s predetermined view always prevail over anybody else´s view. 

 

• CR_02090 Properties tab transition and size 

Problem definition 

Properties and details tab have a lag when opening and there´s a refresh issue when they are not docked. 

Solution definition  

The properties and details tab no longer have a lag while opening. 

 

• CR_21870 Exclude elements from item collection does not work 

Problem definition 

When excluding elements from an item collection with parent item collections, it does not work. 

Solution definition  

The Exclude and Move options now behave as expected. 

 

• CR_21880 S Columns disappear when saving a view 

Problem definition 

The columns of a view disappear when saving it. When retrieving it again, the view displays no columns 

Solution definition  
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Saving a view will no longer discard the existing columns 

 

• CR_21890 Last element in specification is not accessible 

Problem definition 

The last element in the specification is not accessible and cannot be reached. 

Solution definition  

The height of the specification has been fixed to be able to display the last element in the specification 

 

• CR_21360     365   Views Managemente - Sort by options 

Problem definition 

It should not be possible to use the sorting number as an option in the Sorty by - view setting. 

Solution definition  

The sorting number is not available as an option in the Sorty by - view setting. 

 

• CR_21510      89      Mouse selection impossible in dropdown listbox and then anywhere else 

Problem definition 

The mouse seems to be unable to select items in a dropdown listbox, when the listbox was activated 

using the keyboard. At the same time mouse can not be used to select anything else in Visure. The 

selection has to be finished by keyboard before the mouse can be used again.  

Solution definition  

Mouse control has been fixed on the above scenario. 

 

1.7. Visure Requirements 4.9.0 

1.7.1. New features 

1.1.1.18 Advanced export to MS Word 

The existing export to MS Word feature has been completely redesigned to allow users export 

document views in a highly customized way. The new export to MS Word feature allows users to select 

whether to automatically generate tables of contents, tables of tables and tables of images. It also 

supports the definition of different types, and the formatting of these types in the MS Word file. 

1.1.1.19 Captions for tables and images in description 

The description panel includes a new option inside the Insert menu that allows users to insert a caption 

above or below an image or a table in the description of an item. This allows automatically generate a 

table of tables, or a table of figures when exporting to MS Word. 
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The numbering of the table or the figure will display the numbering within the item´s description, until 

they are exported to MS Word, in which case, the automatic numbering will be updated with the 

corresponding number within the document. 

 

1.1.1.20 Code Prefix for items 

Item Collections now have a new system attribute called Prefix. When creating a new item inside an 

item collection that contains a text in that system attribute, Visure will append the code of the new item 

to that text, creating a predefined prefix for those item types. For instance, Product Requirements can 

take a “PR_” prefix, and system requirements “SR_”. 

1.1.1.21 Copy/Paste of items 

The copy/paste of items is now a more intuitive function that allows to create new items starting from a 

set of already existing ones in a very simple way, either within the same project, or across projects. 

In order to copy a set of items, the user should select the source items, select the Copy option (or 

Ctrl+C), select a target item and the Paste option (or Ctrl+V). 

When pasting the items the following information of the original set is duplicated in the newly created 

items:  

• Name and Description.   

• Hierarchy links. 
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• Associated files. 

• Values of attributes (as allowed by item collection assignment). 

• Assignment to item collections for which the “Auto-Assign” attribute is set to either “Assign from 

source”, or “Assign from target & source”. 

• The following information is acquired from the target item: 

• Position: items are pasted next to the target item. 

• Access partition: items are assigned to the access partition of the target item. 

• Assignment to item collections the target item is associated to: this will happen for the item 

collections that have the “Auto-Assign” attribute set to either “Assign from target” or “Assign from 

target & source”. 

• If destination is a document view, and the selected target item is below an item collection, pasted 

items will also be assigned to this item collection. 

Notes: 

• If there is an active item collection when pasting the items, pasted items will be assigned to the 

active item collection.  

• The item information to paste (attributes, hierarchy, etc.) is the current one when the user selects 

the Paste option. It could have been updated since the Copy option was selected. 

• Items can be pasted in the same project of the original set or in another project in the same Visure 

database; in this case, the user needs to log into the new project with the same credentials (login 

name and user role) than he/she used in the source project. 

• Links with other items are NOT copied (except hierarchical links). 

1.1.1.22 Advanced traceability restrictions 

Links between items can be limited according to the linking rules defined in data models. Visure 

Requirements extends this functionality, providing a previously available “Basics Links Restriction” 

mechanism, and introducing a new one, “Advanced Links Restriction”, which allows a tighter control on 

which links are permitted. Considering that each item in Visure Requirements can be associated with 

one or more item collections: 

• Basic Links Restriction: it will be possible to create a link between items if there is at least one link 

relating an item collection associated to the source item, and an item collection associated to the 

target item. The link between item collections shall exist in ANY data model selected for link 

restriction. 
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• Advanced Links Restriction: it will only be possible to create a link between two items if the item 

collections associated to each item meet ALL restrictions explicitly drawn in the data models 

selected for link restriction. 

Let us see some examples of both types of traceability restriction: 

• Basic link restriction: It is appropriate if only one classification criterion determines the links 

between items. For instance, we have a data model like this: 

 

If we apply the basic link restriction selecting this data model, for instance all items belonging to 

User Requirements can be linked to: 

o Any item belonging to System Requirements by the satisfied by link type. 

o Any item belonging to Acceptance Test by the validated by link type. 

• Advanced link restriction: It should be used if we need more than one classification criterion in 

order to restrict the links between items. For instance we have, additionally to the previous data 

model, this one: 

 

This means that the types of items we are going to manage are headings, requirements and tests. 

Headings are just text (titles, comments, etc.) and should not be traced to any other item.  
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Combined with the previous data model, we mean that inside each of the item collections of 

requirements or tests (User Requirements, System Tests, etc.) we will have headings and proper 

requirements or tests. But we want to trace only these ones, not the headings. 

So, in this case we should apply the Advanced Links Restriction option selecting both data models 

to restrict the links. The addition of both models will have the effect that a heading can never be 

traced to any other item even if it also belongs to an item collection in the first data model (like 

User Requirements, System Tests, etc.). 

If we have subtypes of requirements, functional and non-functional, for all requirement levels 

(User, System and Subsystem requirements) with a restrict link type, the data model will look like 

this: 

 

The first data model then has to be modified if we want to be able to create restrict links between 

requirements in the three levels: 

 

 If we want to apply the restrict link only for System Requirements, we should just eliminate the 

restrict link in this data model for the User Requirements and Subsystem Requirements. 
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For both types of link restriction, in case more than one option for a link between two items is allowed 

(several link types and/or incoming or outgoing directions), the user will be able to select the link type 

and/or the direction for the link. 

To activate link restrictions, one of the options Basic links restriction or advanced links restriction has to 

be selected in the Links drop-down menu on the Settings tab of the relevant project in the 

Administration Center. 

 

1.1.1.23 Adding users for baseline signature 

A new Add User button is available in the Electronic Signature tab so that administrators can assign 

users to sign a baseline even after the baseline creation process is finished.  

 

1.1.1.24 Spell checker 

A new spell checker function is now available in the Description panel of elements. The default language 

to be used can be selected by an administrator as one of the project settings in the Administration 

Center. 

Nevertheless, the following dialog is available for all users in the Tools menu in the Description panel:  

 

Users can enable or disable the automatic spell checker function and select the language. When a word 

is enhanced as not recognized by the spell checker, a context menu is available where several correct 

options are proposed or the word can be added to the dictionary. 

1.1.1.25 Default project templates 

A new Templates option is available for selection of templates in the project creation process. This step 

of the creation process displays a list of available project templates (ipt files) in the installation folder, 
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inside a “Project Templates” folder. These templates feature support to different standards in multiple 

segments including Aerospace and Defense (DO-178B/C & DO-254), Automotive (ISO 26262), Medical 

Devices (IEC 62304 & FMEA), Railroad (CENELEC EN 50128 & FMEA) and Agile. 

This list can be extended with customer specific templates, supporting their own organizational needs. 

They can be used as a starting point to create templates tailored to the organization needs. 

1.7.2. Enhancements and Usability Improvements 

1.1.1.26 Support to Windows 10 

Visure Requirements is now fully compatible with Microsoft Windows 10 (32 and 64-bit) Operating 

System. 

1.1.1.27 Document View formatting 

The document view has been improved to provide a smoother user experience. 

1.1.1.28 New design of Linked Items tab 

In order to improve performance and usability of the Linked Items tab, two modes are now available 

when displaying the tab: View and Edit.  

The default mode is View; the tab only displays the existing links with other items for the item selected 

in the grid. 

 

When toggling to Edit mode, the tab allows for link creation, edition and removing. 
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The top box shows the items that belong to the item collection selected in the drop-down menu above 

the box and that are not linked to the item selected in the grid. 

Link type and direction can be modified for already created links. 

All menus in the tab (item collection, link type and direction drop-down menus) take into account the 

link restrictions set for the project and only display available options according to these restrictions. 

1.1.1.29 Sorting Number for item collection 

The Sorting Number starts the numbering at the first item, instead of the item collection, providing a 

closer representation of a MS Word specification numbering. 

1.1.1.30 Removing sorting criteria 

A new option has been added to the context menu when right-clicking on the column header to 

facilitate users the possibility to remove all sorting criteria. 

1.1.1.31 Number of digits and alignment for floating attributes 

Visure Requirements allows the possibility to configure the number of decimal digits for floating 

attribute types as well as the alignment. In order to configure these options, simply right click on column 

header of the desired attribute, and select the option. 
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1.1.1.32 New heading number in item views 

A new attribute called Heading Number is now available in item views. It is an attribute of items linked 

to their position in the item hierarchy; it follows the pattern n[.n], where the [.n] is repeated for each 

level in the item hierarchy starting from level 2.  

An attribute Show Heading Number for item collections is now also available. The heading number is 

only visible for those items that belong to item collections with a check in the Show Heading Number 

attribute. 

These properties of items and item collections are intended for building item views simulating the 

numbering we find in documents. We can define item collections to categorize the items according to 

the type of element they represent in a specification (titles, free text, requirements, test cases, etc.) and 

assign to them the Show Heading Number property so that only titles display the associated number. 

This way it is possible to build a document view like this: 

 

 

1.1.1.33 Sorting of attributes in Details tab 

User attributes can now be displayed in the item Details tab in a customized sorting, not only 

alphabetically. Users allowed to modify attributes can manually arrange the list of attributes in the 

attribute view through drag&drop; this sorting can be set by each user in the Details tab using the 

context menu in the heading of the User Attributes section inside the tab. This menu has two options: 

Custom Order and Alphabetical Order. The option set by the user applies to all projects. In order to set 

up this feature, the user can simply right click on the “User Attribute” row category, and select the 

desired sorting. 
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1.1.1.34 New data available in Visure Report Manager 

Suspect attribute for links and text-format description for items are now available as properties to be 

displayed in reports (properties "IsRelationshipSuspect" and "DescriptionTXT"). 

1.1.1.35 Performance improvement in SQL Server Visure databases 

When creating an SQL Server Visure database, the user is now able to select separate file groups for 

data and for indexes (same as the option already available in Oracle to use separate tablespaces). This 

way, performance in the use of SQL Server for Visure databases will be much improved.  

1.1.1.36 New data available for export to HP ALM 

Requirements “Fit-criteria” is now available to be mapped with a text attribute and exported to HP ALM. 

Likewise, “Author” and “Version Author” can also be mapped with any HP ALM text attribute and 

exported from Visure Requirements to HP ALM. 

1.1.1.37 Code and Name removing in item views 

Item Code and Name are not mandatory columns anymore. They can be removed from views, just like 

any other attribute in the grid.  

1.1.1.38 Color filters saved as view settings 

Active filters in Color mode (the elements that fit the filter expression are highlighted in red) are now 

saved as part of the settings in view configuration, same as the ones in Filter mode (only the elements 

that fit the filter expression are displayed).  

1.1.1.39 Access to OLE objects in checked-in items 

Opening OLE objects from the description panel by double-clicking is now available also for checked-in 

items. It is important to note that the objective of this new feature is that users are able to read the 

documents linked as OLE objects even if the item is checked-in, but not to modify them. That is, since 

the item is checked-in, any changes made in the open document will not be stored in the database. 

1.1.1.40 Inline RTF description enabling 

Now the inline RTF description field is enabled in all view types, not only in the document view. 

Furthermore, a new option "Fit inline description to Name column width" is available in view 

configuration. If it is checked, the RTF description will appear right below the Name and occupying the 

same width as the Name column instead of the whole width of the grid view. 
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1.1.1.41 New default and predetermined views 

The menu option to access to the default view of any Visure Requirements element is now called Show 

all. This view displays the list of elements with Code and Name columns and with the Description and 

Properties panels docked and minimized. 

The predetermined view for items is now a document view called Specifications displaying the columns 

Item Types, Check-in/out status, Sorting Number, Code and Name. The Description and Properties 

panels are docked to the right side of the screen and minimized. 

1.1.1.42 New default options in Traceability Tree views  

In traceability tree views, the default options in drop-down menus are now the most commonly used: 

- Select Link Type menu: All 

- 2nd Level menu: Filter first level 

1.1.1.43 New default options in Project Settings 

Some project settings default options have been redefined in order to ensure they are the most 

commonly used:  

- Enable Links Restriction: Enabled  

Every new data model is enabled automatically. The administrator needs to uncheck it explicitly in 

case it is not intended to restrict links. 

- Allow empty names: Enabled 

- Enable changing of attribute values with Write (own) permissions: Enabled 

- Project description configuration: Enabled 

o Check description margins: Enabled 
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o Check supported image formats: Enabled 

o Format: The one configured in the Windows system for all applications. 

- Automatic hierarchy when creating elements: Yes 

- Fit columns size to window size: No 

1.1.1.44 Default background color for selected items 

The default background color for selected items in the grid is now the one defined by RGB: 151-203-255. 

This default option only applies if the user has not selected another one in the Color Configuration 

menu. 

1.1.1.45 User filtering in baseline creation 

When creating a new baseline, users can be selected for baseline signature; now the list of available 

users only displays the ones assigned to the project in which the baseline is being created. 

1.1.1.46 User sorting in User Group Members tab 

In the Administration Center, when selecting a user group in a project, sorting is now enabled in the 

Members tab by clicking on any column heading. By default, first click over a column sorts values in 

ascending order. 

1.7.3. Solved Issues 

1.1.1.47 Visure Requirements Client (13) 

• CR_IC_16066 -  CA-2012-03-00004616 – Filter formula messed up 

Problem definition 

After adding a new value to an enumerated attribute type, if this type was used in a term of a compound filter, the 

position of this term in the filter is now the last one, so the compound filter is modified and becomes a different 

one from the intended filter. 

Solution definition  

Now the position of terms in compound filters is kept in all cases, even when an enumerated attribute type is 

modified in any way. 

 

• CR_IC_17920 - CA-2015-07-00006155 - Display issue for multivalued attributes 

Problem definition 

In the Properties tab, multivalued user defined attributes with many values assigned to an item are not correctly 

displayed; only the first 15 values are shown in the tab. 

Solution definition  

Now in the Properties tab, when an item has a multivalued attribute with more than 15 values, only the first 15 

values are shown followed by '...' meaning that there are more values assigned to the item. The full list of values 

will be displayed in the tooltip. 
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• CR_IC_17925 - CA-2015-08-00006162 - Hyperlink malfunction with Windows Domain users 

Problem definition 

When Windows Domain is set as default validation system and Current Windows User is checked for the login 

process, if a hyperlink is generated it cannot be used later because the login window, including the OK button, 

appears greyed out, so the user is not able to open the project. 

Solution definition  

When the hyperlink is activated, if Windows Domain is set as default validation system and Current Windows User 

is checked, the username appears in the login window and the OK button is available to the user. 

 

• CR_IC_17941 - CA-2015-09-00006180 – Problem in displaying TIFF-format pictures 

Problem definition 

When inserting TIFF pictures in the description of an item, the picture cannot be seen correctly in the panel. 

Solution definition  

Now TIFF-format pictures are properly displayed in the description panel. 

 

• CR_IC_17973 - CA-2015-11-00006214 - Issue in visualization of new item 

Problem definition 

When adding items in a hierarchical view using Item Template plugin the view jumps away so that the new item 

appears at the bottom of the page. 

Solution definition  

The new item appears below the previously selected one and now the view does not move or scroll. The bug has 

been fixed when adding items in a hierarchical view from Add item and Add child item buttons, and from the Item 

Template plugin.   

• CR_IC_17974 - CA-2015-11-00006214 - Issue in visualization of new items with applied filter 

Problem definition 

When adding a set of new items in a hierarchical view one after another, only the latest one is visible, the previously 

created ones disappear; when refreshing the view (with F5, for instance) all new items are visible. This issue happens 

when a filter is applied (like activating an item collection, for instance). 

Solution definition  

Now, when adding a set of items in a hierarchical view one after another, all new items are always visible. The bug 

has been fixed when creating new items from Add item and Add child item buttons, and from the Item Template 

plugin. 
 

• CR_IC_17975 -  CA-2015-11-00006214  - Issues in visualization after deleting items 
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Problem definition 

In hierarchy views, after deleting items inside a hierarchical level, the selected item is the first one in the view. Also, 

after deleting a parent item, the child items are not displayed in the grid until the view is refreshed. 

Solution definition  

Now, after deleting items inside a hierarchical level, the selected one is the next or the previous item to the deleted 

ones, in the same hierarchy level. And, after deleting a parent item, the child items are visible right afterwards. 

 
 

• CR_IC_17976 -  CA-2015-11-00006214  - Issue in visualization of relocated item in hierarchical view 

Problem definition 

In a hierarchical view, after dragging and dropping an item in a new position in the hierarchy, the view refreshes 

and the relocated item always appears at the bottom of the screen. 

Solution definition  

The bug has been fixed for refresh and drag & drop operations. Now the selected item remains in the same position 

in the windows; it does not jump away to the bottom of the screen. 

 

• CR_IC_18031 -  CA-2016-02-0006290  - Error in English text when assigning item collection 

Problem definition 

In the Properties panel, when modifying the assignment of item to item collections, the dialog shows some tags in 

Spanish in the English version of the tool. 

Solution definition  

The text is now correctly translated into English. 

 

• CR_IC_18046 -  Blank space in items with empty Name field 

Problem definition 

In the document view, items which do not have any content in the "Name" field are displayed with a blank space 

which depends on the height of the font selected for the name. This causes large gaps of empty spaces for most 

items. 

Solution definition  

Now in the document view, if the name of an item is empty, the style height for the name is not applied when the 

item is checked-in. The height is set to the highest cell being displayed (sorting number, columns with attributes, 

etc.) so some blank space is still visible but in most cases the gap is a small one and readability is much improved. 

 

• CR_IC_18078 -  Issue in migration of item descriptions  

Problem definition 
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When migrating repositories, if there is an error in the conversion of an RTF description to HTML, the description is 

not migrated in any format. 

Solution definition  

Now when an error is detected in the migration process related to the conversion of an RTF description to HTML, 

this description is migrated only in RTF and text formats.  

 

• CR_IC_18080 -  CA-2016-04-0006331  - Poor performance when opening project 

Problem definition 

Opening a project is a very slow process in some environments. 

Solution definition  

Performance improvements have been implemented in the data loading when opening a project.  

 

• CR_IC_18088 -  Error in user validation when signing baselines  

Problem definition 

When using Windows authentication, users cannot sign a baseline with their Windows password (an error message 

is shown). However, they are allowed to sign the baseline if the password field is left blank. 

Solution definition  

Now users have to input the correct password in order to sign a baseline for all user validation systems.  

CR_IC_20060 235 Inconsistent selection of elements 

Problem definition 

The hierarchy panel does not synchronize the selection with the grid panel when selecting elements. 

Solution definition  

Now the selection of elements in the hierarchy panel is syncronized with the grid panel 

CR_IC_20100 220 Excel export error 

Problem definition 

When exporting a filtered hierarchycal view to Excel some of the columns contents were shifted. 

Solution definition  

Now export to Excel works correctly even in filtered hierarchycal views 

CR_IC_20890 301 Change Parent 

Problem definition 

When drag and drop elements in a sorted view it was not possible to change the parent of an item. 
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Solution definition  

Now elements can be moved and the change can be changed by drag and drop elements in sorted by views. In case 

of selecting “move at the same level” of an orphan item, the moved item will also become orphan, even if there is 

a sorting criterion. 

CR_IC_21280 317 Access partition on details tab 

Problem definition 

When login with user with restricted rights over the partition were items are located, the access partiion field on 

the details tab is empty. 

Solution definition  

Now the access partition is correctly displayed even if the user has no rights over it. 

CR_IC_21340 237 Format of float 

Problem definition 

The format of float attributes was not configurable, i.e. number of decimals 

Solution definition  

Now it is possible to configure the format of float atributes 

1.1.1.48 Visure Requirements API (1) 

• CR_IC_17900 - CA-2015-07-00006144 - VR-FACE Change Comment/Description 

Problem definition 

The Change description field cannot be accessed through the API; the field is always empty. 

Solution definition  

From now on, the IVersionable "strChangeDescription" property contains the correct value of Change description data. 

 

 

2 Questions? Next steps? 
We hope you found this tutorial useful, but we understand that you may have many more questions. 

Please feel free to contact us at helpdesk@visuresolutions.com for technical questions, or 

info@visuresolutions.com for pricing or licensing information. 
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